Columbia University Finance Training

Troubleshooting Guide: Journal Import Tool

This guide reviews how to download the Journal Import tool, details how to temporarily or permanently enable macros
for an individual Workbook, and provides steps on how to fix the Macro Compile error.

Downloading the Journal Import Tool
1. Create a new folder on your workstation. Give the folder a recognizable name, such as “ITF Journal Uploads” or
“General Journal Uploads”.
2. Log in to https://my.columbia.edu/, click ARC, and scroll down to the Resources section.
Click the Journal Entry Spreadsheet Upload tab.
RESOURCES

TRANSACTION QUICK LINKS =~ REPORTING QUICK LINKS ~ LEGACY REPORTING =~ JOURNAL ENTRY SPREADSHEET UPLOAD = TOOLS & FORMS  TRAINING & HELP

Expandall | Collapse all

General Journal
Please download all files and place them in the same folder.

* Macro
e Journal Import

Internal Transfers
Please download all files and place them in the same folder.

® Macro
* Journal Import

3. Right click on the Macro and Journal Import links and select Save link as... from the menu.

4. Save each file in the folder you created.
Both the JRNLMCRO_WS.xlam and the JRNL1_WS_ITEF.xIsm (internal transfers) or the JRNLMCRO_WS.xlam
and the JRNL1_WS_JE.xIsm (General Journal) files must be saved in the same folder.

If you are using both ITF and General Journal upload templates, the files for each must be stored in separate,
respective folders.

After download, the folder should contain the following two files for Internal Transfers:

Name Date modified Type Size
B5 JRML1 WS _ITEF 101472021 5:03 P Microsoft EBxcel M. 2737 KB
B JRMLMCRO WS 1082021 11:07 AL Microsoft Excel Ad.. 202 KB

Or, the following two files for General Journals:

Mame Date modified Type Size
B3 IRNL_WE_IE 107192021 &13 P Microsoll Bxcel M., 5,546 KA
o JRKNLMCRD WS 10782021 11:07 AL Microsoft Bxcel Ad.. 202 KB
5. Right click the JRNL1 WS _ITEF or JRNL1 WS _JE file and click Properties.
81 JRNLMCRO_WS.xlam & e w
3 Open Enter
$@ Open with >

Y¢ Add to Favorites

0 Compress to ZIP file

Copy as path Ctrl+Shift+C
& Alt+Enter
N

&7 Show more options

The Properties window appears.
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n:- JRNL1_WS_ITEF.xIsm Properties X

General  Security Details Previous Versions

@E. JRNLT_WS_ITEF xIsm

Type offile Microsoft Excel Macro-Enabled Worksheet (xlsm)

Opens with E3f Excel Change
Location C\Users\ez2248\WorkiJournals
Size: 0.98 MB (1.035.643 bytes)

Size ondisk:  0.98 MB (1.036,288 bytes)

Created: Wednesday. March 16. 2022, 2:13:50 PM
Modified Wednesday, March 16, 2022, 2.13:51 PM

Accessed: Today. July 31, 2023, 1 minute ago

Aftributes: [JRead-only  []Hidden Advanced
Security: This file came from another computer| g

and might be blocked to help protect

this computer.

6. For Security, click to place a check in the Unblock option.
Note: The Journal Import tool works only on PC’s running Windows operating systems. The Journal Import tool is not
compatible with computers running MacOS.

Temporarily Enabling Macros for an Individual Workbook
Only enable macros for workbooks that you trust.

1. Open the folder where you saved the files and double click on JRNL1_WS_ITEF file to open the Journal Import
Tool for Internal Transfer Journals or JRNL1_WS_JE file to open the Journal Import Tool for General Journals.
When you first open a macro-enabled workbook, a yellow SECURITY WARNING bar appears below the ribbon.

AutoSave (® off) e -

File Home Insert Page Layout Formulas Data Review View Developer He
é'g Cut . A = — 50 ab
|:| Calibri =11 - A A === - 22 Wrap Text
Paste EE Copy ~ i A
BE I U - = = = = = = | e= 3= | [&] =
- <% Format Painter = e — = = = =3 [E Merge & Center
Clipboard I Font [F) Alignment M
T SECURITY WARNING Some active content has been disabled. Click far more details. Enable Content
Al ~ S

2. Click the Enable Content button to enable macros.
If you don’t want to enable macros, click the X on the far-right of the Security Warning bar.
The Security Warning will disappear, but any attempt to run a macro will fail. If you’ve accidently
disabled macros, close and re-open the workbook to click the Enable Content button.

Note: Opening the VBA Editor or attempting to run a macro before clicking Enable Content will also clear the
Security Warning and disable macros.
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Viewing Macro Settings in the Trust Center

Excel provides settings in the Trust Center to adjust its default behavior when opening macro-enabled
workbooks. To view Trust Center settings:

1. Click the File menu and select Options. The Excel Options window appears.

Excel Options ? X
General
Help keep your documents safe and your computer secure and healthy.
Formulas
Data Security & more
Precfing Visit Office.com to learn more about protecting your privacy and security.
Save Microsoft Trustworthy Computin
Language

Microsofit Excel Trust Center
Ease of Access

The Trust Center contains security and privacy settings. These settings help keep your

Advanced camputer secure, We recommend that you do not change these settings. Trust Center Settings...
Customize Ribbon

Quick Access Toolbar

Add-ins

Trust Center

Cancel

2. Select the Trust Center option and click the Trust Center Settings button. The Trust Center appears.

-

| Trust Center ? X

Trusted Publishers -
Macro Settings

Trusted Locations

Disable all macros without natification
Trusted Documents

® Disable all macros with natification

Trusted Add-in Catalogs Disable all macros except digitally signed macros
Addeins Enable all macros (not recommended: potentially dangerous code can run)

ActiveX Settings Developer Macro Settings

Macro Settings

[ Trust access to the VBA project object medel
Protected View

Message Bar
External Content
File Block Settings

Privacy Options

d Cancel

3. Select Macro Settings. The default setting is Disable all macros with notificiation which allows you to enable
macros from the Security Warning bar. Select this option if it is not already selected.

&2 COLUMBIA UNIVERSITY

IN THE CITY OF NEW YORK
Page 3



Columbia University Finance Training

Troubleshooting Guide: Journal Import Tool

Permanently Enabling Macros for a Workbook

You can set a macro-enabled workbook to be a Trusted Document so that when you re-open it, macros will be
enabled with no security warnings. Trusted workbooks are added to a private list associated with your
Windows login.

1. Open the folder where you saved the files and double click on JRNL1 WS _ITEF file to open the Journal Import
Tool for Internal Transfer Journals or JRNL1 WS _JE file to open the Journal Import Tool for General Journals.
When you first open a macro-enabled workbook, a yellow SECURITY WARNING bar appears below the ribbon

.2. Click the File menu without enabling content so the Security Warning is still visible.

@ Security Warning
Active content might contain viruses and other security hazards. The following
Enable content has been disabled:
Content -

= Macros

All Content st the contents of the file.

Always enable this document's active content
(make this a Trusted Document)

Advanced Options

Select which active content should be enabled.
This content will be enabled for this session only.

3. Click the Enable Content dropdown and select Enable All Content.

Fixing the Macro Compile Error

1. If after opening the JRNL1 WS _ITEF or JRNL1 WS _JE template files, you receive the Compile Error, click OK in
the dialog.

c for Applications - [Interface (Code)]

ew Inset Format Debug Run Tools Add-lns  Window Help
n ok N @ | tno colo

7]

& I(General]

| =} Option Explicit
JRNLL_WS5_ITEF.xlsm)
cel Objects Public Reset As String
(Contral) Sub Auto_Open()
|(Notes) Init
(Template) End Sub
(Template_H) Private Sub Rectangle2 Click()
kbook Set_Cptions

End Sub

Private Sub Rectangle3_Click()
ActiveWorkbook.Worksheets ("Notes") .Activate
End Sub

Private Sub Rectangled4 =% ——"
Call JrnlSheet New Vlicrosoft Visual Basic for Applications X
End Sub

Private Sub Rectanglebd
Call JrnlSheet_Select j  Compile error
End Sub

Private Sub Rectangleé

Call JrnlSheet_Delete

Znd Sub ok | Help | L
Private Sub RectangleT |

C211 TvmiShesr Core

2. Click the Reset button.

s - JRML1_WS_ITEF.xlsm [break] - [Interface (Code)]

re

1l x

ed
Sub or Function not defined —

t Debug Run Tools Add-Ins Window Help

b E@&ﬁ'w @ | Lns, colo
X|

I (General)

| =] Cption Explicit
Fm})
Public Reset As String
| Sub Auto_ Open()
End Sub
Private Sub Rectangle2 Click()

D P

3. Click the Tools menu and select References.
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tions - JRML1_W5_ITEF xl=m - [Interface (Code]]

rmat  Debug ﬂunlIooIsIﬂdd-lns Window Help

Bl @ @I Beferences...l 3

Macros...

Fadsm) Options...

JournalBeok Properties... &

Digital Signature...
[TERd Sub
I | Private Sub Rectangle2 C1

The References window appears.

References - JournalBook

Available References: OK

Visual Basic For Applications
Microsoft Excel 16.0 Object Library
OLE Automation

Microsoft Forms 2.0 Object Library Browse...
Microsoft Office 16.0 Object Library
[w| Microsoft XML, v&.0 ﬂ
Microsoft Scripting Runtime

[ AccessibilityCpladmin 1.0 Type Library Priority
[_] Acrobat Access 3.0 Type Library Help
[] AcroBrokerLib ﬂ

[] Active DS Type Library

[ ActiveMovie contral type library

[ adHnR enartinaFerelClient b

Cancel

e

4. Click Browse button and navigate to the folder where yo

7 Add Reference

u saved the template and macro files.

— i o » This PC » Desktop » ITF

» O Search ITF o
Organize + MNew folder = [ B
-
I This PC - MNarme Date modified Type
B 3D Objects B JRMLY W F 12/21/2021 425 PM  Microzoft Excel M,
I Desktop g JRMLMCRO_WS 12/21/2021 4:20 PM  Micresoft Excel A...
% Dotuments

4 Downloads

B Music

= Pictures

B videos

15 Windews (€
= ns2B40 (WNc-usra
= grp2 (V\c-gp2.ai:

= grpl (Vie-gplan ,, o

>
,| I All Files (*.%) - I

I Open I Cancel

File name:

5. Change the File Type to All Files (*.*) and open the JRNLMCRO_WS file.

References - JoumnalBook

Available References:

x
[ x |

WMSChentMetianager 1.0 Type Library - Cancel I
WorkFoldersShell 1.0 Library
WorkspaceBrokerax 1.0 Type Library
WorkspaceRuntime 1.0 Type Library
WPD MTP Driver for WUDF 1.0 Type Library
WPDSp 1.0 Type Library ﬂ
WPIProvider 1.0 Type Library
wacAPL 1.0 Type Library Help I

Priority

Wscui.cpl 1.0 Type Library

WSHControberLibrary +

WUAPL 2.0 Type Library

ice 1.OT Librar
W

£ >
Jrnimaro

|__Location: _C:lsers\ns2846\Desktop ITF URNLMCRO_Ws.xdem |
Language: Enghsh/United States
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6. Verify that Jrnimcro is selected and that the Location points to the directory where you saved the file (the above is
for example purposes only) and click OK.

7. Click the Save button.

E Microscft Visual Basic for Applications - JRNLU1_WS_ITEF.xlsm - [Interface (Code)]
% File Edit View Insert Format Debug Bun  Tools  Add-Ins  Win
-@ 4 o B EHEFY @
froject - JournalBook EI IlG-eneraI}
| 5] Cption Expl]
Lo ﬁfeg Interface A )
E L Modulel Public Resef
-2 References Sub Auto Opd
— - - - - Trmd+

8. Click the File menu and select Close and Return to Microsoft Excel.

E Microseft Visual Basic for Applications - JRML1_WS_ITEF.xlsm - [Int
é Eile | Edit View |Inset Format Debug Bun  Tools
@l Save JRNL1_WS_ITEF xlsm Ctrl+5 E@' =
roje Impaort File... Ctrl+M (Gene|
Export File... Ctrl+E o
| Remove Interface...
. Py
@ Print... Ctrl+P =
EI: 2 Close and Return to Microsoft Excel  Alt+Q
T TR e OB | Ex
-5 Forms P2

The template file returns.

Insert Page Layout Formulas Drata Review View Developer Help Bl Publisher

‘?'._ o, Cut

- Al 0 - A A= = - 2 Wrap Tea General
5 I3 Copy = . o -
e Fornat Pabrier | B I L= | O A- === |EE BEmegetcene - | 5 - % 7 | W
Clipboard (3 Font a Aljgnment " Humber
D13 = §
;b OLUMBIA |_NIVERSITY BT
_ I(h':'llll CHITY OF r.'EwhlaJkk ITF JOURNAL IMmFPO
Genesal Journal Sheets Impart Journals
r 1 C 1 r

9. Click the Save icon and close and re-open the template file.

Getting Help
Please contact the Finance Service Center
http://finance.columbia.edu/content/finance-service-center

You can log an incident or request a service via Service Now
https://columbia.service-now.com
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